
 

User Manual 
 

 

 

Companion™ User Manual 
Version 5.0.0.0 

Compunetix, Inc. 
Video Systems Division 
2420 Mosside Boulevard 

Monroeville, PA 15146 

April 1, 2014 
 
 

Document Number:  05-CPN-UM-5000 00 

 



 Confidential April 1, 2014 

Version 5.0.0.0  Companion User Manual 

05-CPN-UM-5000 00  Compunetix, Inc. 
 2 Video Systems Division 

TABLE OF CONTENTS 

Getting Started ........................................................................................................................... 5 
Introduction ........................................................................................................................................................ 5 
System Requirements ..................................................................................................................................... 5 
Installing Companion ...................................................................................................................................... 5 
Update Installer .............................................................................................................................................. 15 

Companion User Accounts .................................................................................................. 18 
Basic User Account (Most conservative) ............................................................................................. 18 
Full User Account (Most liberal) ............................................................................................................. 19 

Starting Companion ............................................................................................................... 20 

Companion Main Window ................................................................................................... 22 
Title Bar ............................................................................................................................. 22 
Menu Bar .......................................................................................................................... 23 
Function Buttons ............................................................................................................... 23 
Connection Area ............................................................................................................... 23 
Control Buttons ................................................................................................................. 23 

Companion Menu Bar ........................................................................................................... 24 
Edit ....................................................................................................................................................................... 24 

Call into MCU ....................................................................................................... 24 

Video ................................................................................................................................................................... 24 
Separate Video Window ...................................................................................... 24 

Start Self View ...................................................................................................... 26 

Call Details............................................................................................................ 27 

Image Viewer ....................................................................................................... 28 

View Keypad ........................................................................................................ 29 

Window .............................................................................................................................................................. 29 
Always on Top ...................................................................................................... 29 

Help ..................................................................................................................................................................... 30 
About ................................................................................................................... 30 

Send Log Files ....................................................................................................... 30 

Contacts ..................................................................................................................................... 32 
Connecting to a Contact .............................................................................................................................. 33 

Contact Connection Method Details: ............................................................................... 34 
Creating a Contact ......................................................................................................................................... 34 
Editing a Contact ............................................................................................................................................ 35 
Deleting a Contact .......................................................................................................................................... 35 

Conferences .............................................................................................................................. 36 
Enter an Active Conference ....................................................................................................................... 36 
Activate and Enter a Stored Conference .............................................................................................. 37 
Create a new Active Conference .............................................................................................................. 37 



 Confidential April 1, 2014 

Version 5.0.0.0  Companion User Manual 

05-CPN-UM-5000 00  Compunetix, Inc. 
 3 Video Systems Division 

Edit a Conference ........................................................................................................................................... 39 
Delete a Conference ...................................................................................................................................... 39 

Settings ...................................................................................................................................... 40 
Control Buttons .............................................................................................................................................. 40 

Still Image .......................................................................................................................... 40 
Taking a still image ............................................................................................... 40 

Audio Mute ....................................................................................................................... 41 
Volume Control ................................................................................................................. 41 
Mute Microphone ............................................................................................................. 41 
Video Mute ....................................................................................................................... 41 
Presentation ...................................................................................................................... 42 

Settings Window ............................................................................................................................................ 43 
Options Tab ....................................................................................................................... 44 
Device Options Tab ........................................................................................................... 45 
Connection Settings Tab ................................................................................................... 46 
PWS Settings Tab .............................................................................................................. 47 

Acoustic Echo Cancellation (AEC) ..................................................................................... 49 
Cancel My Echo ............................................................................................................................................... 49 

Setup ................................................................................................................................. 49 
Cancel Remote Echo ..................................................................................................................................... 51 

Setup ................................................................................................................................. 52 

Firewall and NAT Traversal ............................................................................................... 53 
Setup ................................................................................................................................................................... 53 

GNU Gatekeeper Setup ..................................................................................................... 53 
Requirements ....................................................................................................... 53 

Network Deployment Considerations ................................................................. 53 

Installation ........................................................................................................... 54 

Firewall Exception ................................................................................................ 54 

Configuration ....................................................................................................... 58 

Configuration Parameters .................................................................................... 60 

Applying Configuration ........................................................................................ 62 

Companion H.460 Setup ................................................................................................... 64 
EVERGREEN H.460 Setup .................................................................................................. 65 

Changes in Dialing ................................................................................................ 67 

Using H.460 ...................................................................................................................................................... 67 

Troubleshooting Companion ............................................................................................. 68 
Issues Running Companion ....................................................................................................................... 68 

Audio Issues ...................................................................................................................... 68 
Cannot hear the remote terminal or they cannot hear you ................................ 68 

Video Issues ...................................................................................................................... 69 
There is no loop back video when Companion starts up ..................................... 69 

Video is choppy and slow..................................................................................... 69 

Connection/Network Issues .............................................................................................. 70 



 Confidential April 1, 2014 

Version 5.0.0.0  Companion User Manual 

05-CPN-UM-5000 00  Compunetix, Inc. 
 4 Video Systems Division 

Companion won’t connect to a remote terminal ................................................ 70 

Companion connects but local side has no video (remote side has no video).... 70 

Contacting the Compunetix Video Systems Division ................................................. 70 
 



 Confidential April 1, 2014 

Version 5.0.0.0  Companion User Manual 

05-CPN-UM-5000 00  Compunetix, Inc. 
 5 Video Systems Division 

Getting Started 

Introduction 
Companion is a soft video terminal used to create and join video conferences on the EVERGREEN 

system. Since Companion is dependent upon the EVERGREEN system, contacts and conferences located 

on the EVERGREEN can be viewed, edited, created, and called using Companion.  

System Requirements 
 Operating System:  Windows™ XP, or Windows™ 7 (32- and 64-bit) 

 1 GB RAM memory 

 250 MB Free Hard Disk space 

 Java JRE 1.6 update 31 or 1.7 

 Microsoft Visual C++ 2008 Redistributable 

 Webcam (Windows™ XP or 7 compatible) 

 Latest drivers for webcam and soundcard are recommended 

 Connection Bandwidth: minimum 150k symmetrical for 128k (H.323) connection; 460k 

symmetrical for a 384k (H.323) connection is recommended 

Installing Companion 
The user must have administrator privileges on the PC to correctly install Companion.  

Companion requires the Java RunTime Environment (JRE) and the Microsoft Visual C++ 2008 

Redistributable to run correctly. If either is not currently installed on the host machine the installer will 

prompt the user to install it first. 

Because it includes the installation file for Sun’s JRE, the Companion setup program is large.  The 

installation programs can be deleted after the installation is complete.  If the JRE v1.6 is already installed 

on the target PC, then the user can use the smaller setup.exe. 

If there is an existing version of Companion on the PC it must first be uninstalled before continuing with 
the 5.0.0.0 installation. If the existing version of Companion on the PC is version 3.0.0.0 or newer then it 
does not have to be uninstalled. In this case the installer for 5.0.0.0 will run in update mode. If the user 
installed a pre-release version of companion 5.0.0.0, it must first be uninstalled before installing 5.0.0.0. 
See the   
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Update Installer section for more information. 
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To Install Companion: 

1. Double-click the Companion Setup.exe executable to begin the installation. 

 
Figure 1: Setup Executable Icon 

2. If the Java RunTime Environment (JRE) and/or the Visual C++ 2008 Redistributable are 

not already installed, Companion will install them since they are required for 

Companion. Proceed with installing the required software (Java RunTime Environment 

(JRE) and/or Visual C++ 2008 Redistributable) by clicking the Install button. 

a. Occasionally the MV C++ will fail to install. You will be shown an error message box. 

Simply ignore the error and proceed with the installation. 

 
Figure 2: Required Software Screen 

3. Once the Java RunTime Environment (JRE) and/or the Visual C++ 2008 Redistributable 

have been installed, you will see the Companion welcome screen as shown in Figure 3. 

Click Next to proceed with the Companion installation. 



 Confidential April 1, 2014 

Version 5.0.0.0  Companion User Manual 

05-CPN-UM-5000 00  Compunetix, Inc. 
 8 Video Systems Division 

 
Figure 3: Installation Welcome Screen 

4. You will now see the Choose Destination Location screen. The Companion installer will 

automatically select a default location. You can also specify a custom install 

destination. Click Next to proceed with the Companion installation. 
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Figure 4: Destination Screen 

5. On the Customer Information screen Figure 5 

a. Enter the name of the user. This name will appear in the EVERGREEN Contact 

Directory and be used as the default for site captions on EVERGREEN when in 

Continuous Presence mode. 

b. Enter the user’s login name. This is the username set up on the EVERGREEN that will 

allow access. 

c. Enter the PWS IP address (EVERGREEN web server). 

d. (optional) Create desktop shortcut. 

e. Click Next to continue. 
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Figure 5: Customer Information Input Screen 

6. On the Ready to Install screen, click Install. 

 
Figure 6: Ready to Install Screen 



 Confidential April 1, 2014 

Version 5.0.0.0  Companion User Manual 

05-CPN-UM-5000 00  Compunetix, Inc. 
 11 Video Systems Division 

7. Progress screen will update. This may take several minutes. 

 
Figure 7: Companion Installation Progress Screen 

8. After Companion has finished installing, you will be prompted to reboot. 

a. THIS IS NOT OPTIONAL. If the user fails to reboot, Companion will appear to run, but 

will have problems. Please reboot to ensure correct behavior. 
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Figure 8: Restart Computer Screen 

9. Launch Companion after the reboot completes. 
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Figure 9: Launch Companion 

10. The login screen will appear.  The username entered above will pre-populate the user 

name field.  Additionally, the PWS IP address will be added.  Enter the password, and 

click Login. 

 
Figure 10: Companion Login Window 

11. Companion will open in loop back.  If you do not see camera loopback, re-detect the 

audio and video hardware from the Edit menu. 
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Figure 11: Companion Main Window 
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Update Installer 
When there is an existing version of Companion on the PC that is 3.0.0.0 or newer the installer will run 

in update mode. This section describes how to run the installer in update mode. 

1. Double-click the Companion Setup.exe executable to begin the installation. 

 
Figure 12: Setup Executable Icon 

2. You will be shown the Welcome Window. 

a. Click Next to continue. 

 
Figure 13: Update Welcome Window 

3. The installer will now start to update the existing version of Companion to version 

5.0.0.0. 
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Figure 14: Update Installation Window 

4. Once the update is complete the Update Complete window will be displayed. 

a. Select the restart option. 

b. Click the Finish button. 

c. The PC will now be restarted. 

i. NOTE: the PC must be restarted before using Companion, or the installation 

could become corrupted. Please restart when prompted. 
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Figure 15: Update Complete Window 

5. Once restared the new version of Companion is installed on the PC. 
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Companion User Accounts 
Companion’s behavior will vary depending on the user access level to the EVERGREEN. The EVERGREEN 

supports a number of different authentication levels, so depending on how verbose or restricted the 

login is set, Companion Users will experience different behavior. 

Because the settings vary widely, it is not possible to describe each variation of logins. However, below 

are descriptions for the most conservative and the most liberal settings. Contact your Administrator for 

access in between these two examples. 

Basic User Account (Most conservative) 
The Basic User accounts allows only the minimum privileges on the EVERGREEN. Companion Users will 

still be able to login to Companion and dial into a conference using a correct passcode. This User will 

have a limited feature set in Companion. User will not be able to view or access the Conference or 

Contact directory through Companion.  

To create this login: 

1. Login to the xWMC (Maintenance Console) whose PWS Companion is connecting to.  Must 

login as a User who has permissions to create/modify Groups and Users, such as a System 

Administrator. 

2. Navigate to the Groups page using the Group link on the left navigation panel. 

a. If desired Group exists, proceed to step 3. 

b. If desired Group does not exist, create a Group for which this user will belong to. 

3. Navigate to the Roles page using the Role link on the left navigation panel. 

a. Click the Create button to launch the Create Role window. 

b. Name the Role: Companion Basic. 

c. Navigate to each tab and unselect all the permissions except the See Call Service 

permission which should be set to Any resource if Companion will be used with a 4.0.0.0 

or newer EVERGREEN. 

4. Navigate to the Users page using the Users link on the left navigation panel. 

a. Create a new User. 

b. Under the Groups tab, assign this User to the Group from Step 2. 

c. Under the Roles tab, assign this User to the Role from Step 3. 

5. Launch Companion 

6. Log into Companion using the Username and Password you created from Step 4. 

7. You should now be logged into Companion.  The only visible button should be the Settings 

button.  The Contacts and Conferences buttons should be hidden. 

8. At this point, this User has limited accessibility to Companions features.  User will be able to 

enter a correct pass code to enter its associated conference. 
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Full User Account (Most liberal) 
If restricting the Companion Users view is not an issue, then create a full access account. When using 

this configuration, a User will have access to Companion’s full feature set. Users will be able to view and 

access the Conference and Contact directory through Companion. 

1. Login to the xWMC (Maintenance Console) whose PWS Companion is connecting to. 

2. Navigate to the Groups page using the Group link on the left navigation panel. 

a. If desired Group exists, proceed to step 3. 

b. If desired Group does not exist, create a Group for which this user will belong to. 

3. Navigate to the Roles page using the Role link on the left navigation panel. 

a. Create a new Role named Companion Full Access and select the following permissions 

with one of the 3 available selections (Any resource, If resource is public, If resource is 

private).  This will determine if Companion Users assigned this Role can view certain 

resources on the bridge.   

i. Active Confs (See active conference, Create active conference, Modify active 

conference, Delete active conference) 

ii. Active EPs (See active endpoint in conference, Create active endpoint in 

conference, Modify active endpoint in conference, Delete active endpoint in 

conference, Connect active endpoint in conference, Disconnect active endpoint in 

conference) 

iii. Stored Confs (See stored conference, Activate stored conference) 

iv. Contacts (See contact, Create contact, Modify contact, Delete contact) 

v. Call Services (See call service, Only needed with EVERGREEN 4.0.0.0 or 

newer) 

4. Navigate to the Users page using the Users link on the left navigation panel. 

a. Create a new User. 

b. Under the Groups tab, assign this User to the Group from Step 2. 

c. Under the Roles tab, assign this User to the Role from Step 3. 

5. Launch Companion 

6. Log into Companion using the Username and Password you created from Step 4. 

7. You should now be logged into Companion.   

8. At this point, this User has full accessibility to Companions features.  User should see the 

Contacts and Conferences buttons and be able to expand these panels for use. The full feature set 

for both of these panels will be unlocked for use. 
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Starting Companion 
1. Locate and select Companion from the Start Menu. Start > All Programs > Compunetix > 

Companion > Launch Companion. 

2. If Companion detects that multiple Network Interface Cards are present, Companion will display 

the dialog shown in Figure 16. 

 
Figure 16: Select Network Interface Window 

a. The User must contact their Network Administrator to understand which Network 

Interface Card (NIC) to use.  

b. It is possible for the System Administrator to lock out Companion by disallowing access 

to some media networks on the EVERGREEN. If the System Administrator blocks a 

network on EVERGREEN, but the Companion PC still has access to that subnet, then 

Companion will not function. It is important that the System Administrator clearly define 

how Companion will operate in complicated network structures. 

3. The Companion Welcome Screen will then appear as shown in Figure 17, followed by the Login 

Window, as shown in Figure 18. 

 
Figure 17: Companion Welcome Screen 
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Figure 18: Login Window 

4. Enter the IP Address for the EVERGREEN PWS web server, your user name and password, and 

then click Login.  This establishes the connection to the EVERGREEN system and opens the 

Companion Main window. 

 

Figure 19: Network Group Selection 

5. On the first connection to the EVERGREEN PWS web server you may be prompted to chose what 

network group and signaling IP of the EVERGREEN system you would like Companion to use.  

The selected information is used by Companion to determine how it should call the EVERGREEN. 

These settings can later be changed in the Settings window. 

NOTE:  The user can check the Remember Login check box and Companion will prepopulate 

these fields when it launches.  Simply uncheck the box, and Companion will no longer remember 

the username or password. 
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Companion Main Window 
The Companion Main window, as shown in Figure 20, is composed of the following four sections:  

 
Figure 20: Companion's Main Window 

Title Bar 

The Title bBr displays the name of the User. The intial setting is from the installation wizard where the 

user was prompted for their name (Figure 5). However, the name can be changed under settings. To do 

so, open the Settings window by clicking the Settings button. Change the Display Name in the window 

that opens. This will be the name displayed for this Companion user as well as being listed in the 

Contacts Directory on the EVERGREEN to distinguish it from other Companion users. The change is 

dynamic and will take effect immediately. 
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Figure 21: Title Bar 

Menu Bar 

The Menu Bar, shown in Figure 22: Menu Bar, displays the menu options for Companion. Details below. 

 
Figure 22: Menu Bar 

Function Buttons 

The Function Buttons, shown in Figure 23, opens separate windows for Companion settings, contacts, 

and conferences. Details below. 

 
Figure 23: Function Buttons 

Connection Area 

The Connection Area, shown in Figure 24, contains an input field to connect to conferences. Enter the 

Conference Passcode for the conference, and then select Connect to join a conference. This method of 

joining is allowed by every level of user. 

 
Figure 24: Connection Area 

Control Buttons 

The Control buttons, shown in Figure 25, allow a user to control Companions audio and media features 

while connected in a conference. Details below. 

 
Figure 25: Control Buttons 
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Companion Menu Bar 
Companion has four menu choices, as shown in Figure 26: Companion Menus  

 
Figure 26: Companion Menus 

Edit 

Call into MCU 

The Call into MCU setting determines how Companion connects to the EVERGREEN system. If Call into 

MCU is checked, then Companion will dial into the MCU. If Call into MCU is not checked, then the MCU 

dials out to Companion. Companion is designed to dial into the EVERGREEN, however due to NAT 

(network address translation) Firewall technology, it might be necessary for the EVERGREEN to dial out 

to Companion. 

However, this is a preference. Companion will attempt to make the connection if possible. If Companion 

is unable to connect using this setting. It will attempt to dial in the reverse direction to try to make the 

connection if possible. So while this setting allows the user to select the initial connection directions, it is 

not necessarily the why it ends up connecting. 

Video 

Separate Video Window 

To view a separate video window (Figure 27: Separate Video Window), select Video > Separate Video 

Window on the Menu Path. This is the pop out option, so that the video image is not confined to the 

companion Main Window.  

A resizable image window will appear. To view the image or video in full screen, simply maximize the 

separate window. To return the window to the main pane, simply close the separate window. 

While docked in the main video window, it is possible to double click the video pane to pop out the 

video window. This short cut is often preferable to navigating the menus. 

When in floating window mode, Companion will enable a mute tool bar in the bottom center of the 

screen. This bar allows for the mute or unmute of the microphone, speakers, or camera. The tool bar 

will fade during normal operations, however a mouseover will restore its visibility. 
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Figure 27: Separate Video Window 



 Confidential April 1, 2014 

Version 5.0.0.0  Companion User Manual 

05-CPN-UM-5000 00  Compunetix, Inc. 
 26 Video Systems Division 

Start Self View 

To start Self View (Figure 28: Self-view) select View > Start Self View on the Menu Path. This shows a 

separate window of what your camera is sending to the other terminal.  To end self-view, simply close 

the window. 

 

 

 
Figure 28: Self-view 
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Call Details 

To open the Diagnostics window, shown in Figure29: Diagnostic Window, simply connect to the 

EVERGREEN then select Video > Call Details. 

Clicking the buttons at the bottom will toggle between the two windows that contain diagnostic 

information. Simply close the window to stop diagnostics. 

  

Figure29: Diagnostic Window 
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Image Viewer 

To open the Image Viewer Error! Reference source not found., select Video > Image Viewer from the 

enu Path.  From this window, you can view images located on the Companion PC.  This includes screen 

shots taken by Companion. 

                              

Figure30: Image Viewer 

With the Image viewer, you can create a slide show that can be transmitted instead of the camera feed. 

Simply use the browse button to load all the files, and click the ‘Make primary video source’. The slides 

can be manually advanced using the forward and backward buttons, or they can change automatically 

by clicking the Run Slide Show button. 
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View Keypad 

The keypad is no longer needed for Companion in Release 5000. However, the feature was left in case 

the user needed to generate DTMF Tones. (Figure31: Keypad) 

 

Figure31: Keypad 

 Dial String Field 

Enter the desired DTMF sequence in this field 

 Dial Button 

If Instant Dialing is not enabled, use the Dial button to send the DTMF sequence. 

 Transmission Type 

‘Out of Band’ is currently the only supported DTMF transmission type 

NOTE: Not all Video terminals and video devices are capable of both DTMF types.  However, 

 some devices that support both will process both so will actually receive and process 

 duplicate DTMF tones.  If there is doubt, consult the specifications of the device you are 

 sending to.   

 Instant Dialing 

Check this box if you wish to send the tones as the numeric buttons are clicked.  If this box is 

unchecked, then the dial string will not be sent until the Dial button is clicked. 

 Numeric Buttons 

These are the numbers 0 – 9 plus # and *.  Each has a defined DTMF. 

Window 

Always on Top 

Use this option to force Windows to keep Companion on top of all other applications. 

Dial String 
Transmission type 

Transmit tones as 

they are pressed, or 

hold and send at 

once. 

Dial Pad 
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Help 

About 

About will show the versions of the components: 

  . 
Figure32: About Companion 

Send Log Files 

Allows the user to send log files from Companion to Compunetix support. Selecting this menu item will 

display the window shown in Figure33: Log Selection. 

 

Figure33: Log Selection 

This window allows the user to select the date and time that Companion was in operation when 

unexpected behavior was observed. Select that log file to begin the trouble ticket process. If you are 
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unsure, simply select all possible dates. The user can also select multiple times by holding Ctrl while 

selecting. Pressing the Open Log Folder will open Windows Explorer to the folder where the logs are 

being stored. Pressing the Send Selected Logs button will open the window shown in Figure34: 

Information Entry. 

 

Figure34: Information Entry 

The Information Entry window will allow you to enter information about yourself, as well as your 

problem. Enter your name in the Name field. Enter an email address that you can be contacted at in the 

Email field. And enter a description of the problem in the Problem Description field. Press the Send 

button to send your information to Compunetix support. 
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Contacts  
Depending on the user access level set on the MCU, the user may have access to the MCU’s Contact 

Directory. Click the Contact Button to open the Contacts Directory shown in Figure . 

The user can create a conference automatically, by simply double clicking the endpoints in the contact 

list. Alternately, the user can right click a contact to open a menu that offers a connect option. 

NOTE: Contacts shown are directly related to the User’s group. Only users in the same groups can see 

 each other. A user can be in more than one group. A user may also be blocked from seeing the 

 contact directory. The System Administrator must correctly configure each login according to 

 the needs of each user. 

Companion’s user will be automatically added to the MCU contact directory. Upon shutdown, the 

Companion user will be removed from the directory. This gives the Evergreen users an indication of 

which Companion users are available. 

The terminal name in the Contact Directory will match the Display name in the title bar. The user can 

change the name dynamically by opening the settings window and altering the Display Name. 

Contacts can be sorted by ID, Contact Name, or Status by selecting the column header for the related 

field. 
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Figure 35: Contacts Directory 

Connecting to a Contact 
1. Select the Contacts function button to open the Contacts Directory.  

2. Double-cClick any Endpoint in the contacts directory to connect to them  

-OR- 

Right-click a contact entry and select Connect as Non-Presenter or Connect as Presenter.   

3. If Companion is not currently in a conference it will automatically create a conference for the 

user with a host and guest passcode.  The initiating Companion will join the conference as Host.  

The behavior of the conference will be dictated by the conference parameters set.  The default 

setting is to disconnect and erase the conference when the Host disconnects.  If the user wishes 

to have different behavior, the conference can be edited from Companion.  Alternately, a 

preconfigured conference can be set up on EVERGREEN with the desired configuration.  The 

preset would need created using one of EVERGREENS User Interfaces. 

Additional parties joined to the conference through Companion will join as guests. However, if 

parties use the host passcode to join the conference, they will join as hosts. These passcodes 

will appear as the Conference Room number in the Connection Area of the Companion main 

window.  
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Contact Connection Method Details: 

Connect as Presenter (Same as double clicking a contact): 

1. If Companion is already in a conference go to step 3. 
2. If Companion is not already in a conference it will first create a conference.  

a. The conference will be created with presentation enabled, and will use a connection 
profile that supports the most codecs that also allows Companion to present on. 

b. Companion will then connect to the newly created conference. 
3. Companion will make an active endpoint in the conference it is connect to. 

a. The active endpoint will have all the information from the contact withPresentation 
Authorized set to true. 

4. Companion will connect the newly created active endpoint. 
 
Connect as Non-Presenter: 

1. If Companion is already in a conference go to step 3. 
2. If Companion is not already in a conference it will first create a conference.  

a. The conference will be created with presentation enabled, and will use a connection 
profile that supports the most codecs that also allows Companion to present on. 

b. Companion will then connect to the newly created conference.  
3. Companion will make an active endpoint in the conference it is connect to. 

a. The active endpoint will have all the information from the contact with Presentation 
Authorized set to true. 

4. Companion will connect the newly created active endpoint. 
 

  

Creating a Contact 
1. Right-click on the Contacts Directory and select Create. 

2. This opens the Contact window, as shown inFigure 36: Create Contact Window. 

 
Figure 36: Create Contact Window 

a. Enter the name for the contact in the Name field. 

b. Enter the IP address for the contact in the Name field.  
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c. Select what group to make the contact in. The user can select any group in which they 

belong. 

3. Click Create. 

4. The Contact window will close and the new contact will appear in the Contacts Directory. 

Editing a Contact 
1. Right-click on a desired entry and select Edit. 

2.  This opens the Edit Contact window, as shown in Figure , with the selected contact’s 

information. 

 
Figure 37: Edit Contact Window 

3. Modify the selected contact’s information then select Save. 

4. The Contact window will close and the contact’s information will update in the Contacts 

Directory. 

Deleting a Contact 
To delete a contact, right-click on the desired contact and select Delete. The contact will then be erased 

from the Contacts directory.  
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Conferences 
Depending on the user access level set on the MCU, the user may have access to the MCU’s Conference 

Directory. Click the Conference Button to open the Conference Directory shown in Figure .  

NOTE: Users can only see the conferences directly related to the group(s) in which they belong. 

 
Figure 38: Conference Directory 

Conferences are listed according to the following three columns: 

 ID 

The Conference ID is a system-generated number created when the conference is created or 

activated.  The ID is unique for either an Active or an Inactive conference, but not both.  All 

Active conferences are color coded green, while Inactive conferences are color-coded red.  

Therefore, there can be duplicate numbers, but for these cases, there will be one green and one 

red. 

 Name 

The Name is the name of the conference. Conferences started by double-clicking on a contact 

will appear as the Display Name with the User Conference Counter appended. The Display Name 

can be found on the Settings window’s Options tab. 

 Status 

Actively running conferences will be listed in green with ‘active’ in the status column, while 

stored conferences will be listed in red with ‘inactive’ in the status column. 

Enter an Active Conference 
1. Open the Conference Directory by clicking the Conferences function button on the Main 

window. 

2. Double-click on the desired active conference.  You will be automatically joined as a guest 

(NOTE: the conference must be configured with a guest passcode, otherwise the user will not be 

joined to the conference). 

NOTE Companion will only be able to join a conference that contains a guest passcode.  The Companion 

user does not need to know this number, but the conference running on the MCU must have one.  If the 

conference does not have a guest passcode, Companion will warn the user with the popup window 

shown in Figure . 
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Figure 39: Passcode Warning Window 

3. If there is no guest code, but a host passcode, then Companion can join the conference using 

the Host code.  The user would right click the conference, and select “Connect as Host”. 

4. Click Disconnect in the Connection Area of the Main window to close the conference.  

Activate and Enter a Stored Conference 
1. Open the Conference Directory by clicking the Conferences function button on the Main 

window. 

2. Double-click on the desired stored conference. 

-OR- 

Right-click on a stored conference and select Active. 

The conference will activate and a new active conference (green) will form with the same name.  

The inactive conference (red) will remain.  Companion will join the active conference as long as 

there is a Passcode. 

NOTE: The conference will activate with all the settings that were enabled when it was created  

  on EVERGREEN.  For example, if the conference was set to blast dial other contacts, then 

  the contacts will connect automatically. 

The user that activates a conference is automatically placed as the host of the conference. If the host 

disconnects, and the No-Host Action conference feature is set to Break Down and Delete, then all other 

connected parties will be disconnected and the conference will then be erased.  

Create a new Active Conference 
1. Open the Conferences Directory. 

2. Right-click on the Conference Directory and select Create. 

3. This opens the Conference widow, as shown in Figure . 

 
Figure 40: Create Conference Window 
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4. Enter the Name of the conference.  

This required field contains the name of the conference and supports up to 32 characters. This 

text can be changed from the Conference Properties window using an EVERGREEN User 

Interface, or by right-clicking the conference in the conference, window and select Edit from the 

drop down menu. 

5. Enter the Host and Guest Passcode. 

These fields contain the conference passcodes. Passcodes can be between 1 and 18 digits in 

length. Conferences cannot be configured with passcodes that are already in use in the system. 

6.  Select the Connection Profile. 

This field lists the default connection profile that will apply to all endpoints that do not override 

it. The connection profile configures the maximum capability set for the connection. A 

connection profile consists of five parts: video mode, video resolution, frame rate, audio mode, 

and connection rate.  

7. Select the group. 

The group controls the visibility of the conference to other users of EVERGREEN. 

8. Select the Presentation Enabled check box, if applicable.  

If this check box is marked, this conference will have the ability to share a presentation (or any 

files/applications they chose).  This must be enabled to allow H.239 in the conference. 

9. Select the Caption Behavior. 

This field displays whether the text displayed in each continuous presence panel (the caption) is 

Always On, Off, or Temporary After Change (i.e., a configurable amount of time). 

10. Select the caption color. 

This field displays the color of the caption. Options are White on Clear, White on Black, and 

Black on White. 

11. Select the Highlight Talker check box, if applicable. 

Enabling talker highlight places a green border around the panel of the terminal that is currently 

talking. If multiple terminals are sending audio, the highlight box will be around the loudest 

talker in the group. 

12. Select the Panel Borders check box, if applicable. 

Enabling panel borders places a small gray border between the panel views in the mode. 

13. Enter the amount of time the conference can be active in the Duration (min) field. 

14. Select the Auto-Breakdown/Erase checkbox, if applicable. 

If this check box is marked, the system will automatically disconnect the participants and erase 

the conference from the Active Conference List page when the conference Duration expires. 

15. Set the No-Host Action feature. 

This field determines what action to take if a Host does not connect to the conference. Options 

are “Keep Connected” (the default - no action is performed) and “Break Down and Delete” (the 

conference will break down and delete after the specified No Host Duration value set in the 

xWMC (Maintenance Console), if a Host has not arrived. 

16. Select the Self View Enabled check box, if applicable. 

This check box determines whether the endpoint is able to see himself/herself in the display 

mode specified. 
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17. Select the Automatic Selection check box, if applicable. 

This check box allows a user to enable a special mode in which the CP mode changes based on 

the number of connected endpoints. 

18. Select the Conference Video Style, if applicable. 

This check box allows a user to enable a special mode in which the CP mode changes based on 

the number of connected endpoints. The Automatic Selection chooses the smallest CP mode 

that will display all the endpoints in the conference from the ones the user selects. A user may 

select multiple modes, such as 1, 4, 6, and 10. If two people join the conference, the mode will 

automatically set itself to 1. If another connects, the mode will set itself to 4, and so on. 

19. Click Create.  

The conference will appear in the Conference Directory. 

NOTE: Companion cannot create stored conferences, only active ones. 

Edit a Conference 
1. Open the Conferences Directory 

2. Right-click on an Active Conference and select Edit. 

a. Inactive conferences cannot be edited.  

3. This opens the Edit Conference Window shown in Figure  

 
Figure 41: Edit Conference Windows 

4. Modify the properties on the Conference Details window and select one of the following 

options. 

a. Click Save to keep the changes and leave the window open. 

b. Click Save and Close to keep the changes and close the window. 

c. Click Cancel to close the window without making any changes.  

NOTE: Only Active conferences can be edited. Inactive, or stored, conferences cannot be edited 

from Companion.  These can only be modified using an EVERGREEN User Interface. 

Delete a Conference 
To delete a conference, open the Conferences Directory, right-click on the desired conference, and 

selected Delete. The conference will erase from the Conference Directory.  
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NOTE: Only Active conferences can be deleted. Inactive, or stored, conferences cannot be deleted  

 from Companion.  These can only be deleted using an EVERGREEN User Interface. 

Settings 
Companion’s behavior is controlled from two different areas. The Control Buttons and the Settings 

window. The control buttons manipulate the active audio, video or data streams, while the Settings 

window contains all other configurable settings. They are both described below. 

Control Buttons 
The Control Buttons are a series of buttons that affect settings on Companion located directly beneath 

the Main video screen. 

 

Figure 42: Control Buttons 

 

 

 

 

 
 

Still Image 

 

 

 

Taking a still image 

To take a still image: 

1. Click on the “Capture Image” button on the Main Companion Window. 

2. The image will pop up in a separate Image Viewer window. 

3. Click on the “Save” button ( ) in the image viewer to save the image as a JPEG file. 

 

  

Capture Image 

Still image of video screen 

Audio Mute 

Mute the speakers 

Volume Control (%) 

Speaker Volume 

Microphone Mute 

Mute the microphone 

Video Mute 

Mute the camera 

Capture Image 

Still image of video screen 

Present H.239 

Open h.239 presentation window to 

send data to the secondary video 

channel 
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Audio Mute  

 

 

 

Press the audio mute button to stop the sound coming from the speakers. 

 

Volume Control 

 

 

 

Slide knob to adjust the volume. 

NOTE: This is the volume inside Companion and will not adjust the PC volume.  It might be necessary  

    to adjust the PC volume independently. 

 

Mute Microphone 

 

 

 

Press the Mute Microphone button to stop the audio from being transmitted to the connected party. 

Video Mute 

 

 

 

Press the Video Mute button to stop the Video from the camera from being sent into the conference.  

Instead, the hold image will be sent. 

Audio Mute 

Mute the far end audio, so nothing comes 

out of the speakers 

Volume Control (%) 

Speaker Volume 

Mute Microphone  

Mute the microphone, so that Companion 

does not transmit audio. 

Video Mute 

Mute the webcam, so that Companion does 

not transmit the video frames. 
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Presentation 

 

 

 

Press the Presentation button to present the desktop in the secondary video channel from Companion.  

To work, the conference must allow the presentation.  When selected, Companion will open the 

presentation (green) frame, shown in Figure , and begin transmitting everything inside the frame. 

 

 
Figure 43: Presentation Capturing Window 

The frame window can be resized to adjust the area of the desktop that will be transmitted. For 

convenience, the window can be resized to the exact resolution that is being sent using the button in 

the lower left corner of the capturing frame. These buttons will vary based on what resolution video is 

being sent. Figure  shows all the possible buttons. In addition to these buttons the window can be 

manually resized by dragging the box in the lower right corner. This will allow the size to change but will 

lock the aspect ratio of the window to prevent the image being sent from being stretched. If full screen 

is desired, click the box in the upper right corner. 

H.239 Presentation 

Open presenter frame to send data 

to the secondary channel 

 

Full Screen 
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Figure 44: Resize Buttons 

Settings Window 
Press the Settings button to open the Settings window. 

 

Figure 45: Settings Button 

The Settings window provides access to four tabs: Options, Device Options, Connection Settings, and 

PWS Settings. See Figure 46 Settings Window  

 

Figure 46 Settings Window  
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Options Tab 

The Options Tab, shown above in Figure 46 Settings Window, allows users to change general settings for 

how Companion operates. 

 Display Name 

The name that will identify this companion user. The name will be used in the MCU contact 

directory. It will also be sent to the EVERGREEN when it joins the conference. The name will be 

combined with other information to create the endpoint name in the conference. It will also be 

used for site captions of the video terminal as seen by others in the conference. 

 Enable H.460 

This check box if check will allow Companion to use the H.460 protocol for Firewall and NAT 

traversal. It is also required the use of a Session Border Controller. See the Firewall and NAT 

Traversal section for more information. 

 Auto Answer  

This check box if checked will allow Companion to auto-answer incoming calls.  

 Auto-Answer muted 

This check box will mute the microphone when as companions connects. 

 Hold Image 

The video privacy image that will be shown to remote terminals when video mute is on. To clear 

the image, select the “Default Hold Image” button to restore the grey screen. Note: the change 

is instant and does not require the ‘Apply’ button to be clicked. The change is dynamic too, so 

the user does not need to disconnect Companion from it’s conference for the change to take 

effect. Depending on the size of the image, Companion might need some time to scale and 

upload the picture as the hold image. A wait box will appear to let the user know that the image 

is being processed and uploaded. 

 Contact Group 

The default group used by Companion to create contacts. If the user belongs to more then one 

group on the EVERGREEN, this option will allow the user to manipulate the contacts in the 

specified group, as long as the proper configuration is set on the EVERGREEN. 

 Conference Group 

The default group used by Companion to create conferences. If the user belongs to more then 

one group on the EVERGREEN, this option will allow the user to manipulate the conferences in 

the specified group, as long as the proper configuration is set on the EVERGREEN. 

 Network Group 

The network group determines what set of Signaling IPs Companion can use to communicate to 

the EVERGREEN with. 

 Signaling IP 

The EVERGREEN could have multiple Signaling IP address on which Companion can use to call it. 

This option allows a specific signaling IP address to be choosen. You can also specify the Use Any 

IP which will allow Companion to deceide which IP address is best. 
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 Apply 

Saves the current settings. 

 Discard 

Reverts back to the previous setings. 

 

Device Options Tab 

The Device Options tab, shown below in Figure , allows users to view and change video and audio device 

parameters. 

 Video Devices 

The list of video devices connected to the PC. 

 Change Camera 

Changes the camera used by Companion to be the current camera selected in the Video Device 

list. 

 Audio Devices 

The list of audio devices connected to the PC. 

 Change Microphone 

Changes the microphone used by Companion to be the current selected microphone in the 

Audio Device list. 

 Detect Audio and Video Devices 

Companion redetects the devices connected to the PC. 

 Echo Cancellation 

Enables the echo cancellation feature of Comapnio see the Acoustic Echo Cancellation (AEC) 

section for more details. 
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Figure 47: Device Options Tab 

Connection Settings Tab 

The Connection Settings tab, shown in Error! Reference source not found. , allows users to view and 

dit call settings. 

 Maximum Allowable Connection Rate 

The maximum rate of data being sent of received from the EVERGREEN in units of kbps. 

 Maximum Allowable Presentation Rate 

The maximum rate of data to be sent or received for the secondary presentation. 

 H.239 Enabled 

Check box to enable sending and receiving of H.239 presentations. 

 Allowable Video Encoding 

Specifies the video codecs that may be used by Companion to transmit video to the EVERGREEN. 

 Allowable Audio Encoding 

Specifies the audio codecs that may be used by Companion to transmit audio to the 

EVERGREEN. 

 Maximum Allowable Frame Rate 

The maximum frame rate of video transmitted to the EVERGREEN. 

 Video Resolution 

The maximum resolution of the video and presentations that Companion can send or receive. 

 Enable HD 

Enables high resolution video. Disable for low end PCs. 
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 Apply 

Saves the current settings. 

 
Figure48: Connection Settings Tab 

PWS Settings Tab 

The PWS tab Error! Reference source not found. allows user to switch which PWS they are logged into. 

 PWS IP Address 

The IP address of the PWS. 

 User Name 

User name for the PWS. 

 Password 

Password for the PWS. 

 Login 

Logs into the PWS defined by the above properties. 
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Figure49: PWS Settings 
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Acoustic Echo Cancellation (AEC) 
Companion has the ability to cancel out echo while connected in a conference. This provides greater 

flexibility when setting up Companion without having to worry about speaker placement causing echo in 

the conference. Companion provides echo cancellation in two modes, Cancel  My Echo, and Cancel 

Remot Echo. These two different echo cancellation techniques wil be explained in the next two sections. 

The Echo Canceling features are located on the Device Options tab on the Setting Window. An overview 

of the AECcontrols are as follows: 

 Cancel My Echo 

Enables the local echo cancellation. 

o Manual checkbox 

Allow for manual adjustments. 

o Delay Slider (used in the multidelay block frequency domain adaptive filter) 

Adjust the delay in the frequency of the sound manually. 

o Save 

Save the manual adjustments to be used on subsequent companion restarts. 

o Start Detection 

Starts the calibration process for the local echo removal. This is to calibrate when using 

the automatic setting (aka manual not checked). 

 Cancel Remote Echo 

Enables the remote echo cancellation. 

o Manual checkbox 

Allow for manual adjustments. 

o Delay Slider (used in the multidelay block frequency domain adaptive filter) 

Adjust the delay in the frequency of the sound manually. 

o Buffer depth 

How much of the audio to keep and search for echo 

 Microphone Volume 

Adjusts the level of the microphone. 

Cancel My Echo 
Cancel My Echo is used to remove local echo caused by Companion. Local echo is generated by 

Companion’s microphone picking up the sound being played out of the Companion’s speakers. This 

makes it so that participants on the other side will hear their own voice back. Using Cancel My Echo will 

eliminate this echo. 

Setup 

While idle, open the settings window to the Device Options tab, and check the “Cancel My Echo” check 

box as shown in Figure 50: Cancel My Echo below. 
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Figure 50: Cancel My Echo 

Companion will determine the proper delay that can be used to cancel out the echo. The microphone 

and speakers should be set up for a conference call. The volume for the microphone and the speakers 

should be adjusted before starting the calibration process. Once the sound settings are correct, press 

the “Start Detecting” button. Companion will start counting repeatedly while it detects the amount of 

echo for your setup. This process could take several seconds. If the process does not end within 2 

minutes, click the “Stop Detecting” button. This will set the appropriate levels for echo canceling. The 

“Stop Detecting” button is shown in Figure 51: Stop Detecting below. 
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Figure 51: Stop Detecting 

Now when Companion is in a call it will continuously listen to the audio and automatically adjust the 

delay to remove the most echo possible. In some cases the echo may not be completely removed. This is 

due to a variety of factors that fluctuate from connection to connection.  

If the echo is not sufficiently eliminated, check the Manual check box, and adjust the slider manually 

until your echo is removed. Adjusting these values unnecessarily will add unnecessary latency to your 

connection as well as additional processing power from your CPU. 

Once you find a value that eliminates the echo press the Save button to have this value stored for future 

use. Companion will continue to use this saved value until a new value is saved, or the Manual check box 

is unchecked. 

Cancel Remote Echo 
Although echo canceling on an endpoint is only designed to prevent locally generated echo (Companion 

Speakers feeding companions microphone), Companion can attempt to eliminate the echo on the 

remote terminals if the terminal does not have the feature. 

Companions success at removing the remote terminals echo is dependent on a few factors, the greatest 

of which is latency in the network connection. Companion can accommodate at most 500ms for the 

round trip, so 250ms in each direction. 

So if there is a poor connection with a lot of latency, this feature will not work. 
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Setup 

To enable Remote Echo Canceling, open the Settings window to the Device Options tab. Check the 

Cancel Remote Echo check box. This is shown in Figure 52 below. With this turned on Comapnion will 

work to automatically detect the delay and buffer depth needed to cancel out this type of echo. 

 

Figure 52: Cancel Other's Echo 

In some situations Companion will not be able to automatically remove all of the echo coming from the 

remote endpoint. In this situation the Manual check box can be checked, and the sliders can manually 

be adjusted until the echo is removed. Once you find a value that eliminates the echo press the Save 

button to have this value stored for future use. Companion will continue to use this saved value until a 

new value is saved, or the Manual check box is unchecked. 

Manually adjusting the Echo Canceller is complex and requires a working knowledge of acoustical 

engineering. It is hightly recommended to only use the automatic settings. 
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Firewall and NAT Traversal 
Firewalls and NAT(Network Address Translation) devices are network components that make it 

problematic for two parties to communicate with each other over an IP network. Firewall and NAT 

Traversal is a technique used to establish and maintain a connection between two parties across a 

network. H.460 is a series of H.323 extensions that deal with firewall and NAT traversal. Companion 

currently supports the H.460.18 and H.460.19 extensions. For the remainder of this document H.460 will 

be used to refer to Firewall and NAT Traversal. 

H.460 is useful to users of Companion that find themselves in unfavoriable network locations, such as in 

a hotel, or coffee shop. In network locations like this a firewall and NAT is normally located beween 

Companion and EVERGREEN, and a non H.460 connection is unlikely to succeed. Even being connected 

to a home wireless router can sometimes cause problems with connecting Companion to the 

EVERGREEN without H.460 support. 

Setup 
H.460 utilizes a network component called a Traversal Server to facilitate the process of making 

connections between two endpoints. In order for H.460 to work the Traversal Server must be accessible 

by both Companion and the EVERGREEN. Normally the Traversal Server is combined with an H.323 

gatekeeper to provide complete call control. We recommend using the free and open source GNU 

Gatekeeper as a Traversal Server.  

GNU Gatekeeper Setup 

The GNU Gatekeeper is an open-source project that implements a H.323 gatekeeper. A gatekeeper 

provides call control services to H.323 endpoints and is an integral part of most video conferencing 

installations that are based on the H.323 standard.  

Requirements 

1. A Windows PC 

2. Microsoft Visual C++ 2008 SP1 (Can be found at 

http://download.microsoft.com/download/d/d/9/dd9a82d0-52ef-40db-8dab-

795376989c03/vcredist_x86.exe) 

3. GNU Gatekeeper Windows Service ZIP file (Can be found at 

http://prdownloads.sourceforge.net/openh323gk/gnugk-3.5-win32-x86-

application.zip?download) 

4. <PC REQUIREMENTS AFTER SOME BENCHMARKING> 

Network Deployment Considerations 

A gatekeeper provides central call control services for all endpoints that register to it. Because of this 

the gatekeeper should be in a network location that is reachable by all endpoints. This is most likely on 

the public internet with its own public IP address. 

http://download.microsoft.com/download/d/d/9/dd9a82d0-52ef-40db-8dab-795376989c03/vcredist_x86.exe
http://download.microsoft.com/download/d/d/9/dd9a82d0-52ef-40db-8dab-795376989c03/vcredist_x86.exe
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Installation 

This section explains how to install the GNU Gatekeeper as a service on  

1. Extract the gnugk.zip file to a folder you like such as C:\gnugk. 

2. Inside the unzipped folder will be an executable called gnugk.exe. 

3. Double-click gnugk.exe. 

4. You will be shown the following prompt. 

 

Figure 53: GNUGK Install Prompt 

5. Click ‘Yes’ to have the gatekeeper installed as a service and started. 

6. After a short period of time you will be shown the following prompt to verify that the 

installation was successful. 

 

Figure 54: GNUGK Success Prompt 

7. Press ‘OK’ 

8. The gatekeeper will now be started automatically every time the system is started. 

Firewall Exception 

In order for the gatekeeper to function properly the firewall on the PC must allow the Gatekeeper to 

send and receive network data. This section will explain how to add an exception to Windows Firewall 

for the GNU Gatekeeper. If a different firewall is being used on the PC then look in the firewalls 

documentation for how to add an exception for a program. 

1. Open the Control Panel. 

2. Click on the Windows Firewall icon. 
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Figure 55: Contol Panel 

3. Click the ‘Allow a program or feature through Windows Firewall’ link in the left pane. 

 

Figure 56: Windows Firewall 

4. You may have to use UAC to change the firewall settings. 

5. Press the Change settings button if it is not greyed out. 
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Figure 57: Allowed Programs 

6. Press the ‘Allow another program’ button to be shown the window below. 

 

Figure 58: Add a Program 



 Confidential April 1, 2014 

Version 5.0.0.0  Companion User Manual 

05-CPN-UM-5000 00  Compunetix, Inc. 
 57 Video Systems Division 

7. Press the ‘Browse’ button. 

8. This will open a file explorer. 

9. Navigate to the gnugk.exe executable, select it, and press ‘Open’. 

 

Figure 59: Select GNUGK Executable 

10. Now press the ‘Network location types’ button. 

 

Figure 60: Firewall Network Locations 

11. Check which networks types you want to allow the gatekeeper to communicate on. This will 

most likely be all of them. 

12. Press the ‘OK’ button. 

13. Now press the ‘Add’ button. 

14. This will add the GNU Gatekeeper as an exception to the firewall. 
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Figure 61: Firewall Exceptions 

Configuration 

The behavior of the gatekeeper is determined by a configuration file. This section will explain how to 

create a configuration file, how to write the configuration file, and how to make the configuration file 

the active configuration for the Gatekeeper. 

The GNU Gatekeeper looks for a configuration file called gatekeeper.ini in the same folder as the 

gnugk.exe executable. This section will cover how to create it. 

1. Open Windows Explorer and browse to the folder that contains the GNU Gatekeeper 

installation. If following the defaults in this document it will be at C:\gnugk. 
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Figure 62: GNUGK Configuration Directory 

2. Right-click in the folder and select ‘New’ > ‘Text Document’. 

3. This will create a new file in the folder and allow you to rename it. 

 

Figure 63: New Configuration File 

4. Delete all the text, including the ‘.txt’, and type ‘gatekeeper.ini’. 
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5. The new configuration file is now created. 

Configuration Parameters 

This section will describe various configuration items you may want to add to the configuration file 

based on your particular situation. An ini file consists of multiple sections, each with multiple key value 

pairs. An example ini file is shown below. Note that this is not a valid configuration file for the GNU 

Gatekeeper. 

;This is a comment line 

 

;This is the start of a section called ‘Section’ 

[Section] 

;This is a key named ‘key’ which has the value ‘value’ 

key=value 

key2=value2 

 

;This is a section called ‘owner’ 

[owner] 

name=dan 

 

To modify the configuration file used by the GNU Gatekeeper first open the gatekeeper.ini file created in 

the last section with a text editor.  The section below list some of the common configuration items that 

may be used to configure the Gatekeeper. Go over the configuration items below and determine which 

items to add to the configuration file. You can find a more complete list of configuration settings in the 

GNU Gatekeeper’s manual located at http://www.gnugk.org/gnugk-manual.html. 

 Section [Gatekeeper::Main] 

 Name=460Gk 

Default: OpenH323GK 

Sets the name that the gatekeeper uses to identify itself 

 RedirectGK=Endpoints > 100 | Calls > 50 

Default: N/A 

This option allows you to set a maximum number of endpoints that can be registered to the 

gatekeeper, and the maximum number of concurrent calls. 

http://www.gnugk.org/gnugk-manual.html
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 Section [RoutedMode] 

 GKRouted=1 

Default: 0 

If 1, call signaling messages will be routed through the gatekeeper. If 0, call signaling messages 

will be passed directly between the endpoints. This value should be set to 1 for H.460 support. 

 H245Routed=1 

Default: 0 

 If 1, media signaling messages will be routed through the gatekeeper. If 0, media signaling 

messages will be passed directly between the endpoints. This value can be 0, but it is 

recommended to be 1 to help solve some problems with poorly behaving H.323 Application 

Layer Gateways.AcceptUnregisteredCalls=1 

Default: 0 

If 1, the gatekeeper will accept calls from any endpoint. If 0, calls can only be made between 

endpoints that are registered. 

 SupportNATedEndpoints=1 

Default: 0 

If 1, Endpoints behind a NAT will still be allowed to register to the gatekeeper and make calls. If 

0, endpoints behind a NAT will not be allowed to register. 

 EnableH46018=1 

Default: 0 

If 1, enables support for H.460.18 and H.460.19 technologies which provide firewall and NAT 

traversal for endpoints that support it. This is required for H.460 support. 

 H460NoNat=0 

Default: 1 

If 0, H.460.18 will not be used if the endpoint is not behind a NAT and supports H.460.18. If 1, 

H.460.18 will be always be used for an endpoint that supports H.460.18. It is recommended that 

this is set to 1 for H.460. 

 CallSignalHandlerNumber=10 

Default: 5 

The number of threads dedicated to handle signaling/H.245 channels (between 1-200). You may 

increase this number in a heavy loaded gatekeeper. Each thread can process one signaling 

message at time, so increasing this number will increase call throughput. 

 RtpHandlerNumber=10 

Default: 1 

The number of RTP proxy handling threads. Increasing this value helps if you are experience problems 

with RTP packet loss, delay, or jitter on a heavily loaded gatekeeper. 

 Section [Proxy] 

 RTPMultiplexing=1 

Default: 0 

If 1, H.460.19 RTP Multiplexing will be used for H.460 endpoints. If 0, RTP multiplexing will not 

be used. 
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 Section [RasSrv::ARQFeatures] 

 ArjReasonRouteCallToGatekeeper=1 

Default: 1 

If 1, the gatekeeper will reject an answered ARQ without a pre-existing record in the call table 

with reason routeCallToGatekeeper when in routed mode. If 0, answered calls with the other 

endpoint not in the call table are allowed. 

Below is a sample configuration we recommend to use when setting up the GNU Gatekeeper to support 

H.460. 

;H460 Gatekeeper configuration 

[Gatekeeper::Main] 

Name=460GK 

 

[RoutedMode] 

;Enables gatekeeper routed signaling mode 

GKRouted=1 

;Enables gatekeeper media signaling in routed mode 

H245Routed=1;Allow calls from unregistered endpoints 

AcceptUnregisteredCalls=1 

;Allow calls from endpoints behind a NAT 

SupportNATedEndpoints=1 

;Enable H.460.18 and H.460.19 

EnableH46018=1 

;Always use 18 even if endpoint is not behind NAT 

H46018NoNat=1 

;Number of threads to handle call signaling 

CallSignalHandlerNumber=10 

;Number of threads to proxy RTP 

RtpHandlerNumber=20 

 

[Proxy] 

;H460.19 RTP multiplexing 

RTPMultiplexing=0 

Applying Configuration 

To apply the configuration you must restart the gatekeeper. This section explains how to restart the 

gatekeeper. 

1. Locate the gnugk.exe executable used in the installation. This will be at C:\gnugk if you followed 

the recommended location in this document. 

2. Double-click gnugk.exe. 

3. You will be prompted with a message to stop the gatekeeper service. 
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Figure 64: GNUGK Stop Service 

4. Press the ‘Yes’ button. 

5. After a short time you will be shown a screen indicating the shutdown was successful. 

 

Figure 65: GNUGK Success 

6. The gatekeeper is now shutdown. 

7. Double-click gnugk.exe again. 

8. You will be prompted with a message to start the gatekeeper service. 

 

Figure 66: GNUGK Startup Options 

9. Press the ‘Yes’ button. 

10. After a short time you will be shown a screen indicating that the startup was successful. 
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Figure 67: GNUGK Success 

11. The gatekeeper has now been restarted and will be using the latest version of the configuration 

file. 

Companion H.460 Setup 
Companion has one settings option to turn on and off its H.460 capabilities. This option can be found on the    

Options Tab of the settings window. Figure  below highlights the check box that can be used to enable or 

disable H.460. 

 

Figure 68: H.460 Settings 

With this setting enabled Companion will use H.460 in any call situation that it can. If the EVERGREEN 

that Companion is connected to is not setup to support H.460 then Companion will not use it. This 

means that under normal operation this setting can always be left on. 
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When H.460 is enabled, Companion  will try to register with the Traversal Server that the EVERGREEN is 

setup to use. Companion will register with the Display Name that is configurable in the settings. 

Companion displays the registration status in the main interface below the video widow. Figure  below 

show the interface with Companion registered with the Display Name “Dan”. Figure  shows the interface 

when Companion is not registered, in which case the local IP address is shown. 

 

Figure 69: Registered Companion 

 

Figure 70: Unregistered Companion 

EVERGREEN H.460 Setup 

The EVERGEEN MCU must be configured to use the gatekeeper. This is done through the xWMC 

maintenance interface. 

1. Log into the xWOC using an account that has permissions to modify the configuration, such as 

the administrator account. 

2. Go to the Admin page by clicking the link in the top right. 

3. Go to the Configuration page by clicking the link in the left column. 

4. From the configuration page you can change what gatekeeper the EVERGREEN will use. 

5. Press the Unlock button so the configuration can be modified. 

6. Go to the section for gatekeepers. 

7. Press the Add Gatekeeper button to specify the new gatekeeper. 

8. Enter the information in the dialog. 
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Figure 71: Add Gatekeeper 

9. Press the Create button. 

10. The gatekeeper is now configured on the EVERGREEN. 

11. The next step is to set which signaling IPs will register with the gatekeeper. 

12. Select a signaling IP that you would like to have registered with the gatekeeper. 

13. Press the Edit IP Address button. 

14. Check the Register with Gatekeeper check box, and select the gatekeeper from the combo box. 

 

Figure 72: Edit IP Address 

15. Press the Save and Close button. 

16. Do steps 12-15 for every signaling IP address to register with the gatekeeper. 

17. In the end the configuration should look something like this. 
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Figure 73: Sample Configuration 

18. Press the Save Configuration button at the bottom of the page. 

19. Restart the EVERGREEN to have the changes take effect. 

Changes in Dialing 

For H.460 to be enabled on the gatekeeper it must be run in routed mode instead of the default direct 

mode. In direct mode all signaling and media is transmitted directly between the endpoints in a call. The 

gatekeeper only handles access administration. In routed mode all call signaling must be routed through 

the gatekeeper. If an endpoint tries to dial the MCU’s IP directly the MCU will tell the endpoint that it 

must dial the MCU through the gatekeeper. Most endpoints are capable of handling this request and 

then calling the MCU correctly through the gatekeeper. Some endpoints have known issues where the 

call is rejected by the gatekeeper because they do not supply the correct destination address of the 

MCU to the gatekeeper. If this is the case then endpoint should instead register with the gatekeeper and 

dial the MCU through its E.164 number. 

 

Using H.460 
Using H.460 is transparent to a Companion user. Once it is enabled and setup on Companion and the 

EVERGREEN no further action is required to use it. When you make a call with Companion it will use 

H.460 automatically when it is needed. 
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Troubleshooting Companion 

Issues Running Companion 

 

Audio Issues 

Cannot hear the remote terminal or they cannot hear you 

Solution 

1. Make sure the “Mute Microphone” button  , on the main Companion window is not selected 

If the microphone is muted, you will see this image   

Click the “Mute Microphone” button to un-mute the microphone 

2. If you cannot hear the other party then the “Mute Audio”  button is probably pressed 

If the audio mute button is pressed, you will see this image   Click the “Mute Audio” 

button to un-mute incoming audio.  Also, make sure that the volume control is not set to 0. 

 

Additionally, ask the other person if their audio is muted. 

 

Make sure the PC speakers are not muted & the volume is up. 

 
3. If neither the remote terminal nor the local terminal can get any audio then the issue could be 

with the sound card settings: 

 

4. To test your sound card: 

a. Go to the Companion installation directory (Program Files\Compunetix\ Companion. 

b. Open the ringtones directory. 

c. Double-click “ring.wav”. 

d. If you hear a ringing sound then the sound card is working. 

If your sound card is not functioning, try downloading the latest drivers, and retesting (step # 4), 

If the problem still exists, contact the soundcard manufacturer. 
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Video Issues 

There is no loop back video when Companion starts up 

After opening the Companion application, but before connecting to another terminal, the view window 

in the Main Companion window should show loopback. Loopback is the display of what the local camera 

is seeing.  

Solution 

1. Check to make sure that the camera is properly connected, if you are using an external webcam. 

2. Make sure that the camera drivers are up to date and properly installed. 

3. Make sure that the camera is compatible with the Operating System Companion is running on. 

4. Make sure the webcam is not disabled in the control panel.  Webcams are listed in the hardware 

manager window under imaging devices. 

Video is choppy and slow 

Solution 

With an active connection between two video terminals: 

1. Make sure you have enough network bandwidth. This is the bandwidth that is being provided by 

your service provider or network. This bandwidth should exceed the connection rate by 20%. 

For example, for a connection rate of 384kbps, the provided bandwidth should be 384 times 

120% = 460kbps. 

2. Verify that the actual connection frame rate (Video>Call Details) matches the configured frame 

rate (Settings function button>Connection Settings Tab>Maximum Allowable Frame Rate) 

(Edit>Advanced Settings>Video Frame Rate) 

(Recommended frame rate: 30 fps)  

3. Verify that the actual connection rate (Video>Call Details) matches the configured connection 

rate (Settings function button>Connection Settings Tab>Maximum Allowable Connection Rate). 

Connection rates range from 128kbps to 768kbps. 
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Connection/Network Issues 

Companion won’t connect to a remote terminal 

Solution 

1. Make sure that your network is set up correctly and functioning.  

Ping the remote terminal you are trying to connect to. 

From the Start Menu, type: CMD. 

From the DOS Prompt, type: Ping <IP Address of remote site>. 

User should get a Reply from the remote site, if not, confirm the remote IP Address, and 

then have the remote terminal ping your IP address. 

2. Enable the H.460 option of Companion. This option will allow Companion to connect through 

firewalls. 

a. Make sure that the EVERGREEN is also setup to support H.460. This requires the 

EVERGREEN being setup to register with a gatekeeper that supports H.460. 

b. Open Companions setting’s, go to the Options tab, and check the Enable H.460 check 

box. 

a. If H.460 cannot be used consider configuring your firewall to allow Companion to 

operate through it. Confirm that your firewall is configured to allow connection of TCP 

packets on Port 1720. 

a) Confirm that your firewall is configured to allow connection of TCP packets on ports 20000 

to 20200 (note that these ports can be changed.  If the default range is not used, please 

verify that the range used is open on the firewall). 

b.) Confirm that your firewall allows UDP packets to pass for ports 30000 to 30200 in both 

directions (note that these ports can be changed.  If the default range is not used, please 

verify that the range used is open on the firewall). 

Companion connects but local side has no video (remote side has no video) 

Solution 

1. If one side in the conference gets both audio and video but the other side does not, the issue 

could be: 

a. A problem with the firewall (refer to the section above) 

b. Multiple network interfaces on the host computer 

Make sure you select the correct interface on startup 

2. Restart Companion. 

Contacting the Compunetix Video Systems 

Division 
 E-mail: VSDSupport@compunetix.com 

 Telephone: (412) 373-8110 

 Normal Business Hours are 8:00 – 5:00 (EST), Monday through Friday 

mailto:VSDSupport@compunetix.com

